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Introduction 

 

This Tutorial is created to guide you through a data analysis from preprocessing of individual 

datasets to source analysis. We will work with simulated datasets that help to understand 

basic mechanisms. Further we will be working with a real dataset of an auditory intensity 

experiment. In this experiment 10 subjects listened to tones (1000 Hz) of different intensity 

(60, 70, 80, 90, 100dB). We will also work on additional examples dealing with Epilepsy 

cases.  

Note: This is an abridged version of the usual BESA Research tutorial. Furthermore some of 

the examples here are taken from the BESA Guideline for Mapping and Localization in LTM 

tutorial. The latest version of all tutorials can be obtained upon request from 

awaelkens@besa.de . 

Further reading is also available at http://www.besa.de/downloads/training-material/tutorials/ . 

  

mailto:awaelkens@besa.de
http://www.besa.de/downloads/training-material/tutorials/
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Tutorial 1 ï Preprocessing 
 

A. Data Review 

1. Start BESA Research. From the File 

menu, choose Open. In the Select Data 

Files box, select folder ERP-Auditory-

Intensity in the Examples folder. 

Change the file type to ERP files (*.edf, 

*.bdf, *.cnt, *.avg) and open file S1.cnt. 

 

2. This is a dataset recorded from a 32-

channel electrode cap with Cz as 

reference and one EOG channel. Blue 

electrodes are over the left side of the 

head, red electrodes over the right side, 

black electrodes are over the midline. 

Triggers are coded as vertical black bars 

at the bottom of the screen. 

 

 

3. To see the 3D-coordinates of the 

electrodes and additional head surface 

points, select File / Head Surface 

Points and Sensors / View. 

(Alternatively, you can type the short cut 

V on the keyboard.) Fiducials are 

displayed as pink cubicles, electrodes as 

red discs. If you click on an electrode its 

label will be displayed. If you select an 

electrode in the main window, it will be 
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highlighted in the surface points view. 

Close the surface points window. 

4. Select File / Head Surface Points and 

Sensors / Load Coordinate Filesé 

(alternatively: ctrl-L) A window opens 

showing all auxiliary information that is 

associated with the data file. 

 

5. This dialog window allows to specify 

additional information on channel 

configuration (*.ela), digitized head 

surface points (*.sfp, *.eps) and labels 

(*.sfn) and more. Here, no additional 

files need to be loaded as all the 

relevant information is stored within the 

data file. If BESA finds auxiliary files with 

the same basename as the data file, 

they will be automatically loaded. Close 

the window. 

 

 

6. In order to page through your data you 

can either hit the space bar or use the 

arrows in the bottom left corner of the 

main window. The arrows with the 

vertical bar allow you to move half a 

page forward or backward.  
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7. You can also jump directly to a certain 

time-point by pressing Goto / Timeé  

You might also add markers or 

comments to your data by right-clicking 

into the data and selecting Marker or 

Comment. You can then jump directly to 

these events via the Goto menu as well. 

 

8. To rescale your data use the amplitude 

scaling button on the right side of the 

main window (just below the button 

Scp). In the present case the scaling of 

50 µV is appropriate. 

 

9. In order to change the length of the data 

window that is displayed at a time use 

the time-scaling button at the bottom 

right of the main window. In the present 

case 10.0 s is an appropriate viewing 

window.  
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10. If you only want to view a sub-set of your 

electrodes use the button Scp on the 

right of the main window. You can either 

choose the first / second half or the 1st to 

4th quarter of the recorded channels. You 

may also adjust the number of 

electrodes you want to have displayed 

by using the sliders. In the current case, 

change to the all-channel view.  

 

B. Interpolation, Marking of Artifacts, 3-D Mapping, Remontaging 

1. Electrodes that display a faulty recording 

can either interpolate or set as bad. 

Interpolation is based on spherical 

splines, i.e. the information of all other 

electrodes is used to compute the 

interpolated signal. If a channel is set as 

bad it will be ignored. To interpolate or 

set a channel as bad right-click onto 

the according channel label and select 

Define this channel as bad or Interpolate 

this channel1. Interpolated channels will 

be displayed in pink, bad channels in 

grey. In the current dataset there are no 

bad channels and no interpolation is 

needed. 

 

 

                                                           

1 Important note: in case a channel is at located at the rim of the electrode cap it is recommended to set it as bad 
rather than interpolate it as interpolation might be inaccurate. The position of an electrode can be checked 
following step A3 of this tutorial. 
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2. BESA uses amplitude, gradient and low-

signal thresholds when scanning for 

artifacts (see Tutorial 2). Still, you might 

want to specify artifacts in your data by 

hand. This can be useful for e.g. muscle 

artifacts that are high-frequent and small 

in amplitude. In the current dataset Goto 

Time 00:04:28. You will see a muscle 

artifact. Left-drag a window across it, 

right-click into it and select Define as 

Artifact. A red bracket will appear at the 

bottom of the main window marking the 

artifact. It will be ignored for further 

analysis. The artifact marker can be 

deleted by right-clicking on a bracket and 

choosing Delete. Please delete the 

artifact marker in the current dataset. 

  

  

 

3. Goto Time 00:05:49. You will see an 

eyeblink that is mainly picked up by 

electrodes Fp1 and Fp2. Double-click on 

it to open the 3D-Mapping window. You 

will see a strong frontal positivity that is 

typical for eye-blinks in EEG data. We will 

not deal with eyeblinks at this stage. 
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4. It is possible in BESA Research to remontage the recorded data using virtual standard 

electrode caps (VIR-Button) (international 10-10-system) or source montages. In the 

former case you can view the data as if they had been recorded using a standard 

electrode cap. In the latter case data are translated into source space using source 

montages provided by BESA (Src-Button) or created by the user (USR-Button, see 

Tutorial 7) so that you can get an immediate display of activity in the respective sources in 

the continuous recording.  

 

a) Select Vir Reference Free. This virtual montage consists of 27 standard EEG 

channels. The reference was computed as the average signal of an interpolation over the 

complete head surface (approximated by a sphere). Since the physical head model 

assumes a zero integral over the head surface, this type of referencing removes the bias 

of the reference electrode.  Note that the Cz electrode carries signal in this montage. Also 

note that the signal becomes cleaner as the noise that is common to all electrodes gets 

subtracted by average referencing. 

  

b) Select Src BR_Brain Regions. Paging through the data you can immediately see that 
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the left and right temporal sources carry more signal than the other sources. 

 

5. It is possible to view the current montage 

by pressing the EdM button (alternatively 

you can press Edit / Montage). In the 

current case we see a source montage 

that consists of 15 sources covering the 

whole brain. If you click on a source label 

in the middle panel BESA will slice the 

standard MRI to the position of the source. 

You may change to a coronal or saggital 

view by pressing the according buttons 

 . To see different views at the 

same time, press the button . 
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6. In the montage editor press Montage / 

Virtual / Reference Free to change back 

to sensor level. Now you see the position 

of the 27 standard electordes. Note that 

you can create your own montages or re-

reference your electrodes in the montage 

editor as well. Return to the raw data 

using the current montage by pressing the 

 button located in the top left corner of 

the montage window. 

 

 

 

C. Independent Component Analysis (ICA) 

ICA analysis allows decomposing EEG/MEG data into independent components. ICA 

components can be used for artifact correction, as spatial components in source analysis or 

for creating ICA-reconstructed data only containing signal from specified ICA components. 

ICA decomposition is performed on the current screen and can be started from the ICA entry 

in the menu bar or by pressing the ICA button located in the button menu. The amount of 

data available in the current screen can be manipulated by using the time scaling button in 

the bottom right corner of the main window (max. 1200 s). 

The method behind ICA analysis is the extended ICA algorithm (Lee TW et al. Independent 

component analysis using an extended infomax algorithm for mixed sub-Gaussian and 

super-Gaussian sources. Neural Computation 11(2), 1999, 409-433). Before the ICA is 

calculated, the dimensionality of data is optionally reduced by PCA. By default, all PCA 

components are ignored that explain less than 1% variance. The use of PCA can be 

switched off or the variance cutoff can be altered by pressing ICA / Options. 

While ICA is being computed, the current analysis step is displayed in a dialog box along 

with the changing weights. The first ICA step may take longer for many samples than the 

subsequent steps. ICA analysis stops when the change of weights from 1 step to the next is 
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smaller than 1.e-6 or after max. 500 steps. ICA analysis can be stopped by pressing the 

Abort button in the dialog box. 

In case EEG and MEG data are both available, ICA analysis will only run on the data type 

that is selected by the EEG/MEG button. Running ICA on combined 

gradiometer/magnetometer data is not possible as it can only run on one channel type at a 

time.  

1. Please make sure to return to the first 

screen of dataset S1.cnt. Press the 

 button to return to the original 

recording. 

 

2. Please select ICA / Current Screen to 

start ICA analysis.  

 

3. The results of the ICA analysis are displayed like a montage. The units of the waveforms 

are nAm since ICA waveforms can be described as source activity of a spatial component 

localized at the center of gravity of the corresponding map. ICA waveforms have the 

labels ICA1 ï ICAx. The menu item ICA / Current screen is ticked and the ICA button is 

pressed down. ICA components are sorted in descending order of their explained 

variance. The displayed ICA montage is automatically recomputed whenever ICA options 

change or the data change, e.g. when filtering, changing the time-range to display, etc. 

Here, ICA decomposition delivers 21 independent components. It appears that the second 

ICA component represents an eyeblink and the fourth ICA component represents a 

cardiac artifact. 
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4. Right-click on the second ICA 

component and select Map 

Topography. 
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5. The map indicates that the second ICA 

component indeed reflects an eyeblink. 

 

6. We can now use this topography for 

artifact correction. Close the mapping 

window, right-click on the second ICA 

component label and choose Define As 

Artifact Topography. 

 

7. The Artifact Correction window opens. 

Please check the box next to Blink. 

Close the mapping window and press 

OK.  
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8. Return to the original recording by 

pressing the  button. Now press 

Artifact / Correct to switch on artifact 

correction.  

 

9. Note that the eyeblink has now 

disappeared. The topography of the 

second ICA component is now 

subtracted from the data. 

We will learn more about the 

background and other methods of 

artifact correction throughout the tutorial.  

 

10. Please switch off artifact correction 

again by pressing Artifact / Correct. 
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D. Finding spikes by pattern search  

We will use EEG data with bilateral temporal spikes (Temporal_Basal+Polar.foc) and use the spike 
at the 2nd comment TL pol to learn how to do pattern search. 

1. Select the menu item File Ą Close All or close and restart BESA Research. 

2. Select the menu item OpenĄFile or Ą Recent files to select Temporal_Basal+Polar.foc. 

3. Press F3 to set for standard spike review.  

4. Select menu item Goto Ą Time and enter 00:20:19. 

5. Click onto the spike and adjust to peak using the mouse scroll wheel while inspecting the 3D 
map. For better viewing of the map, reduce scale by pressing the [-] button on the right in the map 
window. 

 

6. Press the SAV button (Search/Average/View) to open the search box: 

  

For the first pattern 
search, we will use all 
preset settings (left); i.e. 
the channel having the 
largest marked pattern is 
used (F9_a10). 

Default filters and block 
width will be used with a 
high correlation threshold 
(85%) in single channel 
search. Press OK. 

On the right, settings for 
a spatio-temporal search 
are shown. This uses 
similarity in all channels 
with a lower threshold 
(60%). Query is tick 
marked to check signal 
quality in each detected 
epoch (cf. 8. below) 

7. After the search terminates, the detected epochs are displayed in Selected View for inspection 
and deletion of bad epochs (menu View -> Select, shortcut S). Here, we skip checking each 
single channel detection to perform a spatio-temporal search using all channels in Av33 
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montage. Select View -> EEG (shortcut E) to return to EEG view. The previously marked spike 
block appears again.  

8. For the next pattern search, we will use the whole spatio-temporal 
pattern in the AV33 montage.  

Press SAV, tick All. Detections now go into buffer 2 and are tagged as 
pattern 2 (red). Correlation threshold is set to 60% for the search using 
all channels. Search will be more selective if set higher, e.g. to 65% or 
70%.  

By ticking Query and then pressing OK, you can decide already after 
each detection, whether the signal is clear enough and not 
contaminated in the preceding epoch. Use the keys Y and N to decide. 
After about 20-30 detections, press the button Stop Asking in this 
tutorial to complete the search. This pattern search will be more 
selective and the number of detections smaller because the same 
pattern must be present across all channels. By this spatio-temporal 
search, only spikes with similar topography and propagation are 
detected. 

      

9. After the search is completed, Selected View presents the detected epochs (Pattern 2 in red with 
about 195 spikes, and Pattern 1 in blue with ~130 spikes). Press the key Home (Pos 1) to go to 
the first detection (or drag the scroll button in the time bar at the bottom to the left).  

10. You can now page through the detections using the paging buttons or <Space>, B(ack), and 
N(ext). 

11. If an epoch is contaminated, click into it near the middle and press key D or <Del> to delete. You 
will observe that most epochs have also been detected by the single channel search (Tag1, blue). 

 

 

 

 

 

 

 



BESA® Research 6.0  
Tutorial 1 ï Preprocessing 

 
 

BESA Research 6.0 Tutorial Page 18 of 160 

Copyright © 2014  

BESA GmbH, Freihamer Str. 18, 82166 Graefelfing, Germany www.besa.de 

E. Artifact Correction 

1. Reopen file S1.cnt located in the 

Examples folder ERP-Auditory-

Intensity and switch on the virtual 

Reference-Free view (VIR button Ą 

Reference Free).  

 

2. On the first screen an eye-blink 

dominates the data. Double click on it to 

open the 3D Mapping window and view 

the associated typical strong frontal 

positivity. 

 

3. Close the mapping window and select 

Artifact / Automatic. In the dialog box 

make sure that only the option EOG is 

ticked and leave the settings at default. 

After pressing OK, BESA will now 

automatically scan the data for eye 

movements using an internal model of 

artifact topographies. 

 

 

 

 

 

 

 

4. No horizontal eye movements were found so only a virtual VEOG channel was created 
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by BESA. The eyeblink that was clearly visible in the data before correction is 

prepresented in the virtual VEOG channel. Note that ñcorrectedò is displayed in the top 

left corner of the main window when artifact correction is switched on. You may switch 

artifact correction on and off by pressing ctrl+E or by pressing Artifact / Correct. 

 

5. Next we will do the eyeblink correction by hand. For this purpose, switch off the 

automatic artifact correction and hide the virtual VEOG channel by pressing Artifact / 

View. Switch back to the original data by pressing the Rec button and selecting Original 

Recording. You can see that an EOG electrode was used in this experiment. Scale it up 

to 20µV using the according amplitude scaling button.  
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6. Use the button Add in the top right corner of the main window and select EOG-HB. This 

will add virtual electrodes for picking up horizontal eye movements (H_EOG) and 

eyeblinks (B_EOG). Scale up the B_EOG channel to 200nAM by using the according 

amplitude scaling button. Note that the eyeblink is reflected in the EOG electrode as well 

as the virtual B_EOG electrode. Thus, virtual electrodes can be very useful for the 

identification of eyeblinks if an EOG was not specifically recorded. 
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7. Now we will apply filter settings that are 

optimal for the identification of blinks. 

Press the EdF button to open the filtering 

dialog. Choose a Low Cutoff filter of 

0.5Hz, forward, 6dB and a High Cutoff 

filter of 8Hz, zero-phase, 12dB. 

 

8. Before marking an eyeblink, we need to 

define a default block epoch that will later 

be used for the pattern search. To do so 

press Edit / Default Block Epoch and 

choose the settings Pre cursor: -100ms 

and Post Cursor: 400ms. This time 

window is usually sufficient to cover the 

whole extension of the blink signal.  

 

9. Right-click on the onset of the blink (you 

may use the virtual B_EOG channel as a 

reference) and select Default Block. 
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10. You may select the channels that pick up 

the eyeblink most clearly by holding 

down the ctrl-key and left-clicking on the 

according electrode labels. Select Fp1, 

Fp2 and the virtual B_EOG channel. 

BESA will only use the selected channels 

for the pattern search. However, when 

data are filtered it is often not necessary 

to specify channels, the search algorithm 

may be run using all channels.  

 

11. Before we start the pattern search, we 

will tell BESA to stop everytime a pattern 

is classified as a blink. To do so press 

Search / Query. Next press the button 

SAW (Search ï Average ï Write) to start 

the pattern search. 
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12. Whenever BESA finds a pattern that 

correlates high with the blink we have 

just defined it will ask you if you want to 

accept it to average. Click Yes to move 

on to the next pattern. If you are 

confident that the pattern search works 

well you may select Stop Asking. BESA 

will now automatically scan through the 

rest of the data.2 

 

13. When prompted whether to save the 

average buffer, choose cancel.  

 

                                                           

2 If you data are contaminated by many other artifacts, it is recommended to only accept blinks that do not 

coincide with another artifact event in order to receive a clean eyeblink topography.  
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14. On the left of the main window an 

average segment consisting of all blink 

events that were accepted during the 

pattern search is displayed with a 

baseline of -100ms and a window length 

of 400ms as specified by the default 

block epoch. Left-drag a window in it, 

right-click and select Whole Segment. 

Right click again and specify Define 

Artifact Topography. (If you click next to 

the buffer window, it disapears. It can be 

displayed again by pressing View / 

Average Buffers.) 

 

15. Note that VEOG is already ticked in the 

artifact correction window. The reason is 

that BESA still remembered the 

automatic artifact correction from before. 

Select Blink. An error message will 

appear notifying you that the blink and 

VEOG topographies are too similar and 

that VEOG will be deleted. Confirm with 

OK.  
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16. A 2D-mapping window opens that 

displays the topography of the first PCA 

component (principal component 

analysis) that was computed on the 

average blink signal. The PCA 

decomposes the blink signal into 

independent topographies. Generally the 

first component explains >99% of the 

variance, so it is sufficient to only 

subtract the first component from the 

data3. Open the drop-down menu to view 

the other PCA components. Make sure 

that only the first component is selected 

and press OK. 

 

17. Note that another virtual blink channel 

was created. If you scale it up to 100µV 

using the its amplitude scaling button you 

will see that it is almost identical to the 

virtual blink channel that was created 

automatically using the Add button. 

Switch off H_EOG and B_EOG by 

pressing Add and selecting Switch off. 

Also make sure to swich off artifact 

correction for now by pressing ctrl+E. 

 

 

 

 

 

                                                           

3 It is recommended to only select the first PCA component for artifact correction in order to prevent distortion of 

the data.  
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F. Definition of conditions based on trigger values, names and attributes 

1. We will now use the trigger information in 

the file to specify conditions that will later 

be used for averaging. Press ERP / Edit 

Paradigm. 

 

2. Switch to the Trigger tab. 5 triggers are 

detected in the dataset. They correspond 

to stimuli that were presented at 60dB, 

70dB, 80dB, 90dB and 100dB. Enter 

60dB in the field under name and press 

Add to List. Do the same with the rest of 

the labels.  

 

 

 

3. We will add further attributes as they will make the definition of conditions easier later 

on. Change the name Attribute1 to modality and press Define. In the field below write 

auditory and Add to List. Change the name Attribute2 to side and press Define. In the 

field below write bilateral and Add to List. Change the name Attribute3 to frequency and 

press Define. In the field below write 1000_Hz and Add to List. Change the name 

Attribute4 to intensity and press Define. In the field below again add 60dB, 70dB, 80dB, 

90dB and 100dB to the list. Finally, select Attribute Values/1, name/60dB, 

modality/auditory, side/bilateral, frequency/1000_Hz, intensity/60dB ad press Set. 

Proceed with Attribute value/2, name/70dB, modality/auditory, é 
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4. Switch to the Condition tab. First we want to specify our individual conditions. Enter the 

Name 60dB. Then select Qualifier Current, Attribute intensity, Operator Is, Value 60dB 

and press Insert. Do the same for Names 60dB to 100dB.  

Next we want to specify the condition Low. Enter the name Low and again select 

Current intensity Is 60dB and press Insert. We want the Low condition to also contain 

70dB stimuli. Thus, additionally specify the condition Low to be Current intensity Is 

70dB and press OR instead of Insert. Now, the Low condition contains 60dB and 70dB 

stimuli. Specify condition High to contain 90dB and 100dB stimuli.  

Finally we will specify the condition All by specifying Current modality Is auditory. 

(Make sure your condition definition looks like in the screenshot below.) 
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Note that it is also possible to specify other logic combinations using the Qualifier 

Previous and Next as well as the Operator Is Not. It is also possible to define an interval 

during which a previous or next event can occur under Attribute.  

5. Move to the Epoch tab. Set Averaging 

Epoch to ï300 : 1000, Baseline 

Definition to ï100 : 0, Artifact Rejection 

to ï300 : 1000 and choose Assign to 

All. Important note: We recommend 

using long pre- and post-stimulus times 

to allow for optimum Low Cutoff filtering. 

 



BESA® Research 6.0  
Tutorial 1 ï Preprocessing 

 
 

BESA Research 6.0 Tutorial Page 29 of 160 

Copyright © 2014  

BESA GmbH, Freihamer Str. 18, 82166 Graefelfing, Germany www.besa.de 

6. Move to the Filter tab. Specify a Low 

Cutoff filter of 0.2Hz, 6dB/Octave, 

forward. Enable it for Scan and 

Averaging. I.e. the Low Cutoff filter will 

be switched on for the artifact scan and 

averaging. This prevents us from having 

to filter the averaged data later on and 

we can avoid the negative effect Low 

Cutoff filters can have on relatively short 

data epochs. We will not use a High 

Cutoff filter here as we can apply it later 

without distorting the data. You can now 

save the paradigm definition by pressing 

Save As. Choose any name and add -

test to it in order to not over-write any 

predefined files.  

 

 

G. Artifact rejection based on amplitude, gradient and low-signal criteria. 

1. To make sure you have the identical paradigm settings as described here, please load 

the pre-defined Paradigm-file AEP_Intensity.PDG located in the Paradigm directory 

under Auditory. Move to the Artifact tab and press Start Scan. You will see a 2-

dimensional diagram showing the channels (rows) and trials (columns) having the most 

noise. By default values based on maximum amplitudes within the predefined artifact 

epochs are shown. Epochs that exceed the amplitude threshold (default: 120µV) will be 

excluded from further processing. You can view the number of accepted trials per 

condition in the Count box. As artifact correction is switched off at the moment, a 

substantial number of trials will be rejected.  
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2. Right-click on the red channels to see 

their labels. The two channels that 

contain most bad epochs are FP1 and 

FP2, two frontal electrodes that pick up 

eyeblinks most strongly. Note that it is 

also possible at this stage to change a 

channel status to good, bad or 

interpolated by choosing the according 

option in the dialog box or by dragging 

the horizontal bar up or down. We will 

not do this at the moment, however. 

 


























































































































































































































































